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DOS & Windows file commands 



What is a File 
 A group of organized data (records) which 

are assembled for one particular purpose 

and considered as one unit 

 Stored in permanent storage like hard 

disk, diskettes, etc. 



Types of Files 

 Files can broadly be categorized into two 

types: 

◦ Executable Files 

◦ Non-Executable Files (Data Files) 



What are EXE Files 
 Exe Files: 

◦ Program files that run or execute themselves 

◦ Have either COM or EXE  or BAT as 

extension 

 



What are Data Files 
 Non- executable files that contain only 

the data that we produce 

 Cannot execute themselves 

 Need application program to run 



What is a Command 
 A command is a set of instructions used 

to perform a specific work 

 Interpreted by the OS interpreter to a 

machine language 

◦ E.g. <md Ram>,<cd Ram>,etc. 



Windows 

 In windows it is very easy to do any 

action like creating a file or copying, 

moving, deleting, etc.…. 

 Because the instructions are executed by 

clicking on icons and windows unlike Dos 

operating system. 

 Now create a folder and practice all 

instruction mentioned before ? 



DOS Commands 
 

 Types of DOS Commands 

◦ Internal 

◦ External 

 Directory 

◦ Root Directory 

◦ Parent Directory 



Types of Command 

 Internal Command 

◦ Those commands which are already loaded in the 
Command.COM file while switching to the MS 
DOS 

◦ E.g. CLS, VER, DEL, etc. 

 External Command 

◦ Those commands which are not loaded when 
loading the Program but are available in the Disk 
and can be invoked whenever necessary 

◦ E.g. FORMAT, TREE, XCOPY, etc. 



What is a Directory 
 A directory is a list of file which is itself a 

file stored in the computer’s memory so 

that users can reference it as it is 

required 

 Also called a catalog of files 



Root Directory 
 The Root directory is that directory that 

is automatically created when the disk is 
formatted 

 It is the current drive that we have been 
working  

◦ E.g. A:\, B:\ (for Floppy Disk Drive) 

◦ C:\,D:\ etc. (for Hard Disk Drive) 

 



Current / Parent Directory 

 Current directory is that directory in 

which you are currently working  

 Parent directory is that directory which is 

one level up of the current directory 

◦ E.g. C:\Ram\Hari> 

Root directory 

Parent directory 

Current directory 



Getting into MS DOS 

 To start MS DOS, click 
on the Start button 
and choose Run 

 In the Run dialog box, 
type CMD or 
COMMAND which 
is the EXE file for MS 
DOS 

 Click on the OK 
button 



Listing the Directories and Files in 

MS DOS 

 For listing the Sub-directories and Files 
within a directory, we use the DIR 
command 

 

 Syntax : 

◦ DIR/ [Directory_name] 

 

◦ E.g. C:\>DIR/ NCIT 

 Displays all the directories/files within the directory 
NCIT 

 



1. Dir/ah :-Display all hidden files and directories. 

2. Dir/a-d : - Display  only files. 

3. Dir/ad :- Display only Directories. 

4. Dir/a/s:-Display all directory and file with 
subdirectory. 

5. Dir/a :- Display All Hidden And Non hidden  file 
and directories. 

6. Dir n*.* :Display all file and directory starting 
with ‘ n ’ alphabet. 



Creating a Directory in MS DOS 

 For creating the Directory in MS DOS, we 

use the MD (Make Directory)command 

 

 Syntax: 

◦ C:\> MD NCIT 



Changing a Directory in MS DOS 

 For changing the directory in MS DOS, 
we use the CD (Change Directory) command 

 

 Syntax: 

◦ C:\>CD NCIT 

 Now it appears as:  

◦ C:\NCIT> 

 



Switching between Directories 

 For switching between the directories we 
use the CD.. Or CD\ commands 

 CD.. Command switches from the current 
directory to the Parent directory  

 CD\ command switches from the current 
directory to the Root directory  



Creating Files in MS DOS 

 For creating the files in DOS, the command 

COPY CON is used 

 Syntax: 

◦ COPY CON filename 

 

 

Note: File name should not exceed eight characters excluding three 

characters for extension  

◦ E.g. College1.txt 

◦ To save the file press Ctrl+z then Enter 



Reading Files in MS DOS 
 For reading the Pre-created files in MS 

DOS, we use the TYPE command. It 

displays all the contents that are in the 

file. 

 

 Syntax : 

◦ TYPE Filename 



Renaming Files 
 For renaming the files in MS DOS we use 

the REN Command 

 Syntax: 

◦ REN oldfilename newfilename  



Deleting Files in MS DOS 
 For deleting files in MS DOS we use the 

DEL command 

 

 Syntax : 

◦ DEL Filename 



Deleting directories in MSDOS 

 For deleting the directories in MS DOS 

we use the RD command  

 Syntax : 

◦ RD Directoryname 

 
Note : For removing the directory first the directory should be 

empty 



Checking the Date/Time 

 For checking the date from the system in MS 
DOS, we use the DATE command. It returns the 
current system date. 

 Similarly, the TIME command returns the current 
time from the system. 

 

 Syntax : 

◦ C:\>DATE 

 E.g. C:\>DATE 



External Commands 

Those commands which are not loaded when 
loading the Program but are available in the 

Disk and can be invoked whenever necessary 

E.g. FORMAT, TREE, XCOPY, etc. 

 



The FORMAT Command 
 The FORMAT command prepares a new disk 

for use by organizing the disk into magnetic 
tracks and sectors 

 

 Syntax : 

◦ A:\>FORMAT [Drive_name] 

 E.g.  

◦ C:\>FORMAT A: 



The TREE Command 
 The TREE command is used to display all 

directory pathnames on the specified disk 

 

 Syntax : 

◦ C:\>TREE [disk_name] 

 E.g.  

◦ C:\>TREE A: 



The EDIT Command 

 The EDIT command in MS DOS is used to edit 

the files. It provides a different full screen Editor 

window with a few menu options. 

 Syntax : 

◦ C:\>EDIT [filename] 

 E.g. 

◦ C:\>EDIT file1 



The PRINT Command 

 The PRINT Command in MS DOS is 

used to print the text files 

 Syntax : 

◦ PRINT Filename 

 E.g. 

◦ PRINT File1.txt 



Types of Computers 

 Supercomputers...are used to process very large amounts 
of information including processing information to predict 
hurricanes, satellite images and navigation, and process 
military war scenarios. 

 Mainframes...are used by government and businesses to 
process very large amounts of information. 

 Mini-Computers...are similar to mainframes...they are used 
by business and government to process large amounts of 
information. 

 Personal Computers (PC)… 



 Personal Computers 

 Personal Computers...also known as 

PC’s...are smaller and less powerful than 

the others.  They are used in homes, 

schools, and small businesses. 



Types of PCs 

There are 2 main types of PCs 

 

 Desktop 

 Portable (Notebook/Laptop) 

 When portable (notebook/laptop) computers were first created 
they were HUGE.  They weighed around 100 lbs., and were 
carried in a large luggage suitcase.  The creators of the portable 
(notebook/laptop) computer dreamed that one day it would be 
the size a notebook or pocket dictionary.  With today’s 
technology, we have been able to accomplish this goal and 
more.. 



Parts of a Computer 

There are two basic parts that make up a computer... 

Hardware Software 



Hardware 

Hardware is basically anything that you can 
touch with your fingers. 

 Computer Case 
 CPU (central processing unit...Pentium chip) 
 Monitor 
 Keyboard & Mouse 
 Disk Drive, Zip Drive, CD-ROM, DVD,  
 Hard   Drive 
 Memory (RAM) 
 Speakers 
 Printer 



Hardware (Continued) 

There are three 

types/categories of 

hardware 

 1.  Input Devices 
 2.  Output Devices 
 3.  Storage Devices 



Input Devices 

Input basically means getting data into the computer to 

be processed. 

Keyboard, Mouse,  
Trackball, Touch Pad 
Light Pen, Laser Scanner,  
Pointing Stick 
Touch Screen,  
Bar Code Reader, Scanner 
Microphone, Joystick 



Output Devices 

Output basically means getting data out of the 

computer. 

Monitor 
Printer 
Speakers 
Headphones 
Modem 
Fax 



Storage Devices 

 Storage devices are both input and output 
devices in one.  A storage device is a place to 
keep data that has been processed so that it 
can be retrieved at a later time to be used 
again. 

Hard Disk 
Floppy Disk 
CD’s, DVD’s 
Magnetic Tape 
Flash Memory, Jump Drive 



Software 

 Software is the programs and applications that tell 
the computer what to do and how to look. 

 Computer programmers write the 
codes/instructions that make-up software 
applications/programs. 

 HTML is a type of computer programming language 
that allows programmers to make web pages. 

 The next 2 slides show what HTML codes look like 
and the web page the codes produce. 



Two Types of Software 

Application Software 

 

 

 

Operating System 

Software 



Operating System Software 

 Directs all the activities and sets all the 
rules for how the hardware and software 
will work together. 

  

 Examples would be:  

   DOS, Windows 95, 98, ME, NT, XP, 
Vista, Windows 7 

  Unix, Linux,  

  MAC system OS 6,7,8,9,10 



Command Line Operating Systems 

DOS is an example of a command line operating 
system. 

 

On the next slide, Notice that there are no: 

  Icons (pictures) 

  Colors 

  Mouse Pointer 

  Buttons 

  You have to memorize commands in order  to use 
this text based operating system. 





Operating Systems: GUI 

 GUI stands for Graphical User Interface 

Uses pictures (icons) to represent files, folders, 
 disk drives, modems, printers, etc. 
GUI’s were created to make using a computer 
 easier, more interesting, non-threatening 
 to inexperienced users. 
A mouse allows users to point at something and 
 click to make it work.  With command line 
 you have to have all of the commands to 
 make your programs work. 
Here is an example of a GUI 





Application Software 

 Programs that work with operating system 
software to help the computer to do specific 
types of work. 



Application Software 

 There are six basic types of application 

software... 



Application Software 

1. Business software: word processors, spreadsheets, and 

database programs. 

2. Communication software: allows computers to 

communicate with other computers: fax software, 

Novell NetWare, AOL, Modem Software. 

3. Graphics software: software that allows users to create 

and manipulate graphics...Photoshop, Print Shop, etc. 



Application Software 

4. Education and Reference software: Programs that help teach 
new material and ideas, and programs that can be used to 
find information... Worldbook Encyclopedia,  

5. Entertainment and Leisure software... Age of Empires, Barbie 
Design Center, Solitair 

6. Integrated software: Combines several types of software 
into one program or package... Print Shop (Graphics/Word 
processor). 
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Introduction To Computer: 

A computer : is a general purpose device that can be programmed to carry out a set 

of arithmetic or logical operations. A computer is really a system of many parts 

working together. The physical parts, which you can see and touch, are called 

hardware. (Software, on the other hand, refers to the instructions, or programs, that 

tell the hardware what to do.) 

 

 

Computer operations: 

1. Receive input   (Data raw facts). 

  2.Process data according  to   predefined instruction. 

  3.Produce output (information which is meaningful data)  
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Computer Components: 

   There are many parts that work together to make a computer work. 

Hardwar: 

 Physical parts of the computer, including processor and memory chips, 

input/output devices, tapes, disks, modems, cable, etc. 

 

Three main group will be studied in details: 

Central Processing Unit (CPU). 

Memory (primary && secondary). 

I/O devices. 

A. CPU : 

- CPU (Central Processing Unit) process the data that had entered by one of input 

devices. also called (microprocessor). 

- It’s  the brain of Computer. 

- It’s  speed is measured by MHz (Mega Hertz). 

- Consists from one or more chips and circuits 

- Determine how powerful and fast is the computer  

 

Parts of a CPU: 

1.  Arithmetic and Logic Unit (ALU):  

Performs arithmetic operations and logical operations. and control the speed of 

those operations. 

        2. Registers:  are (Immediate Access Memory) 

-  locations used by the ALU to store the data in execution. 
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- And to store Program instructions which are used by the Control Unit 

       3. Control Unit (CU): 

Supervises  all operations inside the PC, (Tells the rest of computer system how to 

carry out a program’s instructions.) 

B.Memory: 

The computer stores data and  information into special places called memory, this 

memory enables the user to get his data whenever he want. 

There are two main types of  computer’s memory: 

Primary memory. 

1. RAM (Random Access Memory) ,is the location where data and programs are 

stored (temporarily) ,RAM is volatile, means that the data is only there while 

the power to the computer is turned on( when the computer is shut off, the 

content of RAM is erased). 

2. ROM: (read only memory): It is another part of the main memory. That has a 

very small capacity main memory, keeps instructions, which make the 

computer work when turning it on. It is not volatile , The computer cannot 

write on it. 

Secondary memory.  

This memory is used to keep software, programs and data permanently. Also 

called(Storage Devices, Secondary Storage System, External Storage). 

   1-Hard Disk : is the most important storage media in the computer system , it 

keeps software and programs it is composed of several magnetic disk,Have 

different sizes. 

2-Floppy disk: is small and portable magnetized disk in plastic case ,  It is used to 

transfer files from one computer to another it is slower than the hard disk   

is an optical disk which uses laser  :)compact disk read only memory( ROM-CD-3

to read information, It is suitable for storing multimedia software, needs a 

special device to write and read from it 

4-USB flash drives :  Are compact and easy to use that are similar to hard drives, can 

be put in pockets or around neck or in a keychain 
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Data Representation in the Memory 

Bit :     1 or 0 (binary form). 

Nibble:     4 bits (a half of byte). 

Byte: A group of 8 Bits,  Memory unit represent 1 character,  it is used to measure the 

memory capacity. 

Kilobytes(KB):      about 1000 byte exactly it is1024 Bytes. 

 

Megabyte(MB):     about 1 million byte exactly it is1024x1024 Bytes. 

Gigabyte(GB): about 1 billion byte exactly it is1024x1024x1024 Bytes. 

Terabyte(TB): about 1 trillion byte exactly it is1024x1024x1024x1024 Bytes. 

 

 

 

C- Input/ output  Devices: 

Input device : Allow you to input data to the computer. 

Key Board: contains the (Characters, Numbers, Symbols, Functions and specialized keys. 

Mouse: A small hand-held device. When it is moved, a rolling ball on the underside 
transmits information to move the pointer.  

Touch Pad: It is a touch-sensitive device. When the finger moves on its surface, the 
Pointer will move. It is Usually used in laptops and some keyboards 

        Scanner  :Converts page contents text, image into electronic signals. These signals can  

         then be stored in a computer and manipulated. It can also be used to read bar codes.:          

        Microphone : used to record the sound on the computer or input spoken text into the  

          word processor. 

       Digital Camera: the same as traditional camera but use the flash or disk to  store images.  

        Can be connected to computers. 
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Output device : Allow you to output information from computer. 

       Screen (monitor): display the work being done by the CPU, display the result of the                   

      processing, display texts, graphics, images, forms and so on. 

      Printers: used to print the soft copy (data) to hard copy on papers. 

      Speakers: used in multimedia to produce sounds. 
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Operating System 

Operating System (OS): is a collection of software that manages computer 

hardware resources and provides services for computer programs. 

Operating System : a program that controls the execution of application 

programs and acts as an interface between the user of a computer and the computer 

hardware. 

Operating System :acts as a general manager supervising   the activity of each 

component in the computer system. 

 

 

 

Types of operating systems 

 

1. Real-time 
A real-time operating system is a multitasking operating system that aims at 

executing real-time applications. Operating system switches between tasks based on 

their priorities. 

2. Multi-user 
A multi-user operating system allows multiple users to access a computer system at 

the same time. Time-sharing systems and Internet servers can be classified as multi-

user systems as they enable multiple-user access to a computer through the sharing 

of time. 
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3. Distributed 
A distributed operating system manages a group of independent computers and 

makes them appear to be a single computer. The development of computers that 

could be linked and communicate with each other gave rise to distributed 

computing. When computers work together, they make a distributed system. 

 

4. Embedded 
Embedded operating systems are designed to be used in embedded computer 

systems. They are designed to operate on small machines like PDAs(A personal 

digital assistant). They are able to operate with a limited number of resources. They 

are very compact and extremely efficient by design. Windows CE and Minix 3 are 

some examples of embedded operating systems. 

 

The components of an operating system all exist in order to make the 

different parts of a computer work together : 

 

Kernel 
The kernel is a computer program that manages input/output requests from 

software and translates them into data processing instructions for the central 

processing unit(CPU). 

 

 
 

Memory management 
The kernel has full access to the system's memory and must allow processes to 

safely access this memory as they require it. 

Device management 
The kernel access to the (input and output devices) through device drivers. A device 

driver is a computer program that enables the operating system to interact with a 

hardware device. It provides the operating system with information of how to 

control and communicate with the hardware parts. 
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System calls 
A system call is how a program requests a service from an operating system's kernel 

that it does not normally have permission to run. System calls provide the interface 

between a process and the operating system 

Alaa Omer Najim



Microsoft Word 

Introduction 



Microsoft 

Word… 

…is the word processing component of the Microsoft 
Office Suite. 

 

It is used primarily to enter, edit, format, save, retrieve 
and print documents. 

 



The area outlined in red is called the 

title bar. 

 

It displays the names of the open 

program (in this case Microsoft  Word) 

and the name of the current file. 
 

 

 



This file has not yet been saved so its 

name is Document1. 

 

Files created in Microsoft Word are often 

referred to as documents and have the 

file extension .doc or .docx 
 

 

 



The area outlined in red contains the 

minimize, maximize/restore and close 

buttons for the program window. 

 

 

 

 
 



These three buttons are on almost every 

window that opens in a Windows based 

platform. 

They are on Mac windows as well, but 

they are circles instead of squares. 
 

 

 
 



When you click the minimize button the 

program becomes a button on the 

Windows taskbar located at the bottom of 

the screen. 
 

 

 

 

 

 



You can restore the document to its 

original shape and size by either: 

Clicking on the button on the task bar one 

time to restore it to active mode, 
 

 

 

 

 

 



If you have multiple files from the same 

program open you will need to select the 

one you want to restore to active mode. 

 

 

 
 

 
 



When you click the maximize / restore 

button the program assumes the same 

shape and size it was before you 

minimized it. 

Or 

The program window will fill the screen. 
 

 

 



When you click the close button the 

program will ask you if you want to save 

the changes if you have made any 

changes. Once you have responded to 

this question the program will close. 
 

 

 

 

 



The area outlined in red is called the 

quick access toolbar. 
 

It contains the most commonly used 

commands in Microsoft Word: 
 

1. Save 

2. Undo 

3. Repeat 
 



Microsoft Office 2007 & 2010 use what is 

referred to as the “Ribbon” interface. The 

area outlined in red comprises the 

Ribbon. 
 

The ribbons we are going to go over 

today are the default ribbons. 
 

 



You may customize the ribbon and or a 

group on the ribbon on your personal 

computer to have only the features you 

want to use. 

In order to do this all you have to do is 

right mouse click on the ribbon or the 

group you want to customize. 
 



The Words File, Home, Insert, etc… 

outlined in red are referred to as tabs. 

Each tab has several Groups attached to 

it. 
 

 
 

 

 

 

 



The File Tab menu contains the commands 

most commonly associated with the file. 
 

 



The Home Tab Groups contain the commands 

most commonly associated with the formatting and 

editing of text. 
 

 

 

 

 

 
 

 

Clipboard Font Paragraph 

Styles Editing 



The Insert Tab Groups contain the commands 

most commonly associated with adding 

something to the document. 
 

 

 

 

 

 

 

Pages Tables Illustrations 

Links 

Header/Footer 

Text 

Symbols 



The Page Layout Groups contain the 

commands most commonly associated with 

settings that would affect the entire page or 

document. 
 

 

 

 

 

 

 

Themes Page 

Setup 

Page 

Background 

Paragraph Arrange 



The References Groups contain the 

commands most commonly associated with 

writing a research paper, essay, term paper or 

similarly formal documents. 
 

 
 

 

 

 

Table 

of Contents 
Footnotes Citations & 

Bibliography 

Captions Index Table of 

Authorities 



The Mailings Tab groups contain the 

commands most commonly associated with 

documents and files created for mass mailing. 
 

 

 

 

 

 

 

 

 

Create Start 

Mail Merge 

Write & Insert 

Fields 

Preview 

Results 
Finish 



The Review Tabs groups contain the 

commands most commonly associated with 

documents which are shared or being prepared 

for publication. 
 

 

 

 

 

 

 

 

Proofing Language Comments 

Tracking 
Changes 

Compare 

Protect 



The View Tab groups contain the commands 

most commonly associated with the variety of 

ways you can “look at” a document or 

documents. 

 
 

 

 

 

Document 

Views 
Show Zoom 

Window Macros 



Summary 

•Word processors have features that make it 
easy to create documents.  

•Consider both the content and look of the 
document. 

•Create copies of documents and back up 
changes at every opportunity. 
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Font Attributes 
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Size 

Font 

Style 

Color 

Special Effects 

Preview 



Font Attributes (continued) 
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Text Effects 

Text Effects 

Effects 
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L6: Basics and Descriptive Statistics

Introduction to Excel



we can use Excel to: 

1. Store and organize data, 

2. Analyze data, and 

3. Represent data graphically (charts) 



Excel Basics 

This is a row.   

Rows are represented 

by numbers along the 

side of the sheet. 

This is a column.   

Columns are 

represented by letters 

across the top of the 

sheet. 

Excel spreadsheets organize information (text and 

numbers) by rows and columns: 



Excel Basics 

A cell is the intersection 

between a column and a 

row.   

 

Each cell is named for the 

column letter and row 

number that intersect to 

make it. 
 



Data Entry 
There are two ways to enter information into a cell: 

1. Type directly into the 
cell. 
Click on a cell, and type in 
the data (numbers or text) 
and press Enter. 

2. Type into the formula 
bar. 
Click on a cell, and then 
click in the formula bar (the 
space next to the      ).  Now 
type the data into the bar 
and press Enter. 



Data Entry 
1. Open Excel (Start  All Programs  MS Office  Excel). 

2. Enter the following information into your spreadsheet: 



Formulas and Functions  

 Formulas are equations that perform 

calculations in your spreadsheet. Formulas 

always begin with an equals sign (=). When 

you enter an equals sign into a cell, you are 

basically telling Excel to “calculate this.” 

 

 Functions are Excel-defined formulas. They 

take data you select and enter, perform 

calculations on them, and return value(s).  



More on Functions 

 All functions have a common format – the equals 

sign followed by the function name followed by the 

input in parentheses. 

 The input for a function can be either: 

 A set of numbers (e.g., “=AVERAGE(2, 3, 4, 5)”) 

 This tells Excel to calculate the average of these numbers. 

 A reference to cell(s) (e.g., “=AVERAGE(B1:B18) or 

“=AVERAGE (B1, B2, B3, B4, B5, B6, B7, B8)” 

 This tells Excel to calculate the average of the data that 

appear in all the cells from B1 to B8. 

 You can either type these cell references in by hand or by 

clicking and dragging with your mouse to select the cells.  



=AVERAGE(first cell:last cell): calculates the mean المعدل 

=MEDIAN(first cell:last cell): calculates the median الوسيط 

=MODE(first cell:last cell): calculates the mode القسمة بالعدد الصحيح 

=VARP(first cell:last cell): calculates the variance التباين 

=STDEVP(first cell:last cell): calculates the standard 

deviation الانحراف المعياري 
 

 You may directly write the functions for these statistics into 

cells or the formula bar, OR 

 You may use the function wizard (       in the toolbar) 

Below are several functions 



Functions for Descriptive Statistics 

 Your Excel 

spreadsheet should 

now look like this: 



example 

 In Excel, there are many functions that can  
calculate a correlation statistic علاقة احصائية, 
however, we will only use =PEARSON in this 
class. 

 

 Let‟s say we want to determine if there is a 
relationship between number of hours spent per 
week studying and degree earned in the class at 
the end of the semester. To do so, we can 
calculate Pearson‟s r for our two variables. 



Enter the following data into Excel: 

StudyHrs = average number of hours spent per week studying 
 

GPA = grade-point average earned in the end of the semester 



Step 1: Select the cell where you want your r 
value to appear (you might want to label it). 

Step 2: Click on the function wizard      button. 

Step 3: Search for and select PEARSON. 



Step 4: For Array1, select all the values under StudyHrs. 

    For Array2, select all the values under GPA. 



Step 5:! Once you have your r value, don‟t forget 

to round to 2 decimal places. 



Charts 

 

 A chart is an excellent way to visually display 

the relationship (correlation) between two 

variables. 

 Each point on the chart represents an 

individual‟s data on the two variables. 

 

 We will now create a chart for StudyHrs and 

GPA.  



Step 1: Select both columns of variables you 
wish to plot (StudyHrs and GPA). 

Step 2: Click on the tab labeled „Insert‟, and then 
select „Scatter‟ in the „Charts‟ menu. 



Step 3: Select the first plot in the drop-down menu. 



Step 4: Remove the legend by clicking on it 

and pressing Delete. 



Step 5: Add axis titles by selecting the „Layout‟ tab 

and clicking on „Axis Titles.‟ For the horizontal title, 

you want it below the x-axis. For the vertical title, 

you want the „Rotated Title‟ option.  

NOTE: Your chart 

must be 

highlighted for 

the „Layout‟ tab to 

appear under 

„Chart Tools.‟ 



 For scatterplots, it does not matter which variable 

goes on each axis (this is NOT true for other 

types of charts). 

 However, you need to make sure you label your 

axes with the proper variable name. 

 In this example, GPA is on the y-axis and Study 

Hours is on the x-axis (we can tell this based on 

their different ranges of values). 

  As a helpful hint, Excel will automatically put the 

first variable (left-hand column) on the x-axis, and 

the second variable (right-hand column) on the y-

axis. 

A note about x- and y-axes: 



Step 6: Change the chart title by selecting it, typing a 

new one, and pressing Enter. Chart and axis titles 

may be altered by right-clicking on them.   



Your scatterplot is now finished!   

*Each point in the scatterplot represents an individual‟s data. 


